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Making Basic Measurements: a self-paced training 
guide

This book teaches you how to set up and make measurements with the 
Agilent Technologies 16700-Series Logic Analysis Systems using the 
credit card board provided in this kit.

What materials do I need?

You need the following materials to make measurements using the 
credit card board:

• One Agilent Technologies 16700-Series Logic Analysis System with a state/
timing measurement module. To do chapter 8, you will also need an 
oscilloscope measurement module, and to do chapter 9, you will need a 
pattern generator measurement module.

• A monitor, keyboard, and mouse (unless you have the Agilent 
Technologies 16702A or 16702B).

• This training kit (Agilent part number 16700-60007).

• Probe assembly (Agilent part number 01650-61608) or a termination 
adapter (Agilent part number 01650-63203).

If you are using an older analyzer

If your logic analyzer interface appears different than the interface 
used in this training kit, then you have an analyzer with the older 
interface. There is a training kit for these analyzers that you can 
download from the web.

To download the manual off of the web:

1 Go to http://www.agilent.com/find/logicanalyzer-manuals.

2 Select “Making Basic Measurements, Training Kit for the Agilent 
Technologies 16600A/16700A-Series Logic Analysis System 
(PDF).”

You can either print the manual from the web page now, or you can 
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save the PDF file to your hard drive and open it later (you must be able 
to read PDF files on your computer).

• To print the manual from the web page now, select File, and then Print... 
and specify how you want it to print.

• To save the PDF file to your hard drive, select File, and then Save As... 
Select the directory you want to save the file in and select Save.
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In This Book

You can use this book in two ways: you can start with chapter 2 then 
progress chapter by chapter, or you can start with chapter 2 then 
randomly access the exercises you want to do with minimum setup.

Part 1: A Quick Tour

❏ Chapter 1, A Quick Tour, introduces you to logic analysis, your logic 
analysis system, and the steps you must take to make a measurement.

Part 2: Making Basic Measurements

In Part 2, you make real measurements with the credit card board.

❏ Chapter 2, Before You Begin

❏ Chapter 3, Introduction to Timing Analysis: Trigger on an Edge

❏ Chapter 4, Verify Pulse Widths

❏ Chapter 5, Introduction to State Analysis: Trigger on an Event

❏ Chapter 6, Trigger on a Sequence of Events

❏ Chapter 7, Trigger on a 4 Bit Serial Pattern

❏ Chapter 8, Trigger the Oscilloscope with the Timing Analyzer

❏ Chapter 9, Using the Pattern Generator

Part 3: Reference

Part 3 contains information about the credit card board and how to set the 
jumpers on the board.

❏ Chapter 10, Setting the Jumpers

❏ Chapter 11, All About the Credit Card Board
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What Other Sources of Information Are There?

Installation Guide

The Installation Guide is a booklet that explains how to set up your 
Logic Analysis System.

Online Help System

The Online Help System gives you task help for the analyzer system 
and tools, as well as descriptions and conceptual information. The Help 
system also has a glossary section. 

• To access online help, select Help from the icon bar.

Measurement Examples

Measurement Examples guides you through performing measurements 
with your system. Many common data measurements are described 
with instructions for setting up the analyzer.

• To access measurement examples, select Help from the icon bar. Choose 
On Main System, then select Measurement Examples from the Help 
window.
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A Quick Tour

Welcome to your new logic analysis system. You have the Agilent 
Technologies 16700-Series logic analysis system. 

Your Agilent Technologies 

16700-Series Logic Analysis 

System

The Agilent Technologies 16700 
Series logic analysis system frame 
has five slots for measurement 
modules, and two dedicated 
emulation module slots.

The Agilent Technologies 16702A-
Series logic analysis system also 
includes a built in flat-panel 
display and keyboard. 

The Agilent Technologies 16702B-
Series logic analysis system also 
includes a built in flat-panel 
display with touchscreen 
capabilities.
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Chapter 1: A Quick Tour
A Quick Tour
When Should I Use a Logic Analyzer?

In general, a logic analyzer is useful when you are beyond the 
parametric stage of design, and you are interested in timing 
relationships among many signals and need to trigger on logical highs 
and lows. Logic analyzers are particularly useful when looking at timing 
relationships or data on a bus. It can decode the information on 
microprocessor busses and present it in a meaningful form. 

What is a Logic Analyzer?

Logic analyzers grew out of oscilloscopes. They present data in the 
same general way that an oscilloscope does; the horizontal axis is time, 
the vertical axis is voltage amplitude. But a logic analyzer does not 
provide as much voltage resolution or time interval accuracy as the 
oscilloscope. Instead, it can capture and display dozens or more signals 
at once - something that an oscilloscope cannot do. 

A logic analyzer reacts the same way as your logic circuit does when a 
single threshold is crossed by a signal in your system. It will recognize 
the signal to be either high or low. The analyzer can also trigger on 
patterns of highs and lows on these signals.

Up to now, the term “logic analyzer” has been used rather loosely. In 
fact, a logic analyzer can be configured as a timing analyzer, a state 
analyzer, a state and timing analyzer, or as two state analyzers.

What is a Timing Analyzer? A timing analyzer is analogous to an 
oscilloscope. It samples at regular time intervals, and displays the 
information in a waveform similar to the oscilloscope. Because the 
waveforms on both instruments are time-dependent, the displays are 
said to be in the “time domain”.

What is a State Analyzer? A state analyzer samples when you tell it 
to using an external clock. Each time the state analyzer receives a state 
clock pulse, it samples and stores the logic state of the system under 
test. The data can then be viewed as a sequential listing of logical 
states. 
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Chapter 1: A Quick Tour
A Quick Tour
The Main System Window

The Main System window is your starting point for setting up and 
making measurements. It graphically shows which instruments are 
installed in the frame.
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A Quick Tour
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Chapter 1: A Quick Tour
A Quick Tour
The Measurement Process

Define the type of measurement. Define how you want to sample 
data by selecting state mode or timing mode, and by setting up the 
state clock.

Set up the bus labels. Specify which signals you want to analyze by 
grouping and labeling the signals.

Define trigger conditions. Define the trigger conditions and events 
to control what the analyzer captures.

Run the measurement. Capture the data specified by the trigger 
conditions.

Examine the data. Use the waveform or listing windows to search, 
mark, and measure the data. It is common to go back and modify the 
trigger conditions to capture different data.

Sampling 
tab

Format tab Trigger tab
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Before You Begin

Before you begin the exercises you must connect the credit card board, 
power up the Agilent Technologies 16700 logic analysis system, and 
save a default settings file named RESET for resetting the system at 
the beginning of each chapter.

Start Here If you have not already connected the credit card board to the logic analyzer, follow 
all of the steps in this chapter.

If you have connected the credit card board, go to step 3.

Connect Pod 1 to the 
Credit Card Board

Agilent Technologies logic analyzers group their probes into pods. Each 
pod contains 16 data probes and a clock probe. For all exercises, you 
will use Pod 1 to probe J1 on the credit card board.

1 With the power off, connect Pod 1 to J1 on the Credit Card 
Board.

If you are using a multi-card analyzer, connect pod 1 of the master 
board to the credit card board.
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Chapter 2: Before You Begin
2 Set the jumpers on the credit card board as shown below.

Chapter 10 “Setting the Jumpers” for more information on the jumper 
settings of J5 on the credit card board.

Turn the Power On

3 Turn on the Agilent Technologies 16700 logic analysis system by 
flipping the power switch to ON.

Activate the Analyzer

4 Once the Main System window comes up on your screen, select 
the analyzer you have connected to the credit card board.

5 Select Setup... from the pop-up menu to activate that 
instrument.

If you should ever connect the credit card board to a different 
analyzer, you must repeat steps 4 through 5 before going on to step 8.
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Chapter 2: Before You Begin
Activate the Scope If you have an oscilloscope module, you’ll need to create a RESET file 
for it also.

6 In the Main System window, choose the oscilloscope module, 
then select Setup/Display... from the pop-up menu.

Activate the Pattern 
Generator

If you have a pattern generator module, you’ll need to create a RESET 
file for it also.

7 In the Main System window, choose the pattern generator 
module, then select Setup... from the pop-up menu.

Create the Training 
Directory

If you have already created the directory /logic/training/, go to step 12.

8 Select the File Manager icon from the icon bar.

9 Select the Create Directory tab.

10 Under Directories, go to the directory /logic/.

11 In the New Directory name field, enter ‘training’, and then 
select Create Directory.
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Chapter 2: Before You Begin
Create the RESET File

12 Under Directories, go to the directory /logic/training/, and 
select the Save tab.

13 In the File Name field, after /logic/training/, enter RESET.

14 Select Save to save the default setting of all the measurement 
modules you are using. You will load this RESET file before each 
chapter to default all settings. If you connect the credit card 
board to a different analyzer instrument, you must start at step 4 
to make a new RESET file.

15 Select Close to close the File Manager window.

16 Go to the Setup window for the logic analyzer and select File, 
and then Close.

17 If you activated the oscilloscope, go to the Oscilloscope window 
and select File, then Close.

18 If you activated the pattern generator, go to the Pattern 
Generator window and select File, then Close.
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Chapter 2: Before You Begin
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Introduction to Timing Analysis:
Trigger on an Edge

Timing analysis with a logic analyzer is much like tracing a signal with a 
digital oscilloscope. The timing analyzer, like the oscilloscope, samples 
the signal at a rate determined by an internal clock.

The analyzer differs from the scope in that the analyzer uses one-bit 
comparators to output two signal levels, a logic 1 or 0. This allows the 
analyzer to have many more channels than the oscilloscope. With a 
large number of channels, the analyzer can show the timing 
relationship of logic between various signals. For example, you could 
look at the logic levels on control lines versus address lines or data 
lines.

.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
In this chapter, and in chapter 4, you will make basic timing 
measurements. This chapter steps you through setting up the timing 
analyzer and bus labels, setting up the analyzer to trigger on an edge, 
and viewing the waveform.

In this chapter, you will learn how to:

❏ Set up the timing analyzer.

❏ Set up the bus labels

❏ Trigger on an edge.

❏ Run the analyzer and view the waveform.

❏ Use markers to make a timing measurement.

❏ Save your work.
 29



Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Load the RESET Configuration File
Load the RESET Configuration File

The RESET file defaults all settings so that you can begin the 
exercises. You created the RESET file in Chapter 2.

1 Decide what to do.

• If you have just completed chapter 2, go to the next page.

• If you have reconnected the credit card board to a different 
analyzer, or if you have not created a RESET file, go to chapter 2 
“Before You Begin.”

• If you have just completed an exercise other than chapter 2, go to
step 2.

2 Select the File Manager icon from the icon bar.

3 Under Directories, go to the directory /logic/training/.

4 Under Contents of ‘training’, select RESET file with the file 
description of the analyzer you have connected to the credit card 
board.

For example, if you are using an Agilent Technologies 16717A, you will 
select ‘RESET.__X’ with the file description of ‘16717A_LA_Config’.

5 Select the Load tab.

6 Select Load.

7 Select Yes.

8 Select Close.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Set Up the Timing Analyzer
Set Up the Timing Analyzer

Because the logic analyzer can capture dozens or even hundreds of 
signals, you need to organize the signals by grouping and labeling 
channels. Your goal is to create meaningful labels for groups of 
channels that represent the signals you are interested in. For example, 
you could group the channels used to probe the address bus under the 
label ADDR. 

1 Select the analyzer you have connected to the credit card board.

2 Select Setup... from the pop-up menu to activate that 
instrument.

3 Select the Sampling tab.

4 Select Timing Mode.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Set Up the Bus Labels
Set Up the Bus Labels

1 Select the Format tab.

Now you will organize the data you are capturing by creating a label 
and assigning the channels of interest to that label.

2 Select Label1, choose Rename.

3 Change the label name to TCOUNT.

TCOUNT is short for timing count, and represents the source of the 
signals.

4 To the far right of TCOUNT, select the field showing the 16 
channels of pod 1.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Set Up the Bus Labels
5 Assign the lower 8 channels of pod 1 to TCOUNT by choosing 
“........********”.

15 0

15 14 13 12 11 10 9 8 3 2 1 07 6 5 4

* * * *** * *. . . ... ..

Pod 1

78

The channels of Pod 1
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Define Trigger Conditions: Trigger on an Edge
Define Trigger Conditions: Trigger on an Edge

A term that should be familiar to oscilloscope users is “triggering”. It is 
also used in logic analyzers, and is often called “trace point”. Unlike an 
oscilloscope, which starts the trace right after the trigger, a logic 
analyzer can show information prior to the trace point, which is known 
as negative time, as well as information after the trace point.

You can trigger the analyzer using specified events and edges. In this 
exercise, you will use the rising edge of bit 7. 

1 Select the Trigger tab.

2 Under the Trigger Functions tab, select ‘Find edge’.

Trigger functions are predefined trigger sequences that can be 
used “as is” or that can be combined and modified for creating 
more complex trigger sequences. 
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Define Trigger Conditions: Trigger on an Edge
3 Select Replace to replace the default trigger sequence with the 
‘Find edge’ trigger function.

4 Under Trigger Sequence 1, select .

5 Set Bit 7 as a rising edge and all other bits as don’t care.

6 Select OK.

Your trigger should read:

You have finished setting up the analyzer to trigger on the rising edge 
of bit 7. You are now ready to run the analyzer and capture data.

This is the rising 
edge of bit 7.

This is the group of 
channels you are 
analyzing.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Run the Analyzer and View the Data
Run the Analyzer and View the Data

1 Select the Run icon to capture the data.

2 Select the System icon.

3 Select the slot with the analyzer you are using, and choose 
Waveform from the pop-up menu.

4 To the right of the Seconds/div enter 20 ns. This will zoom in on 
the waveform.

The data you captured is displayed in overlay mode, with the entire bus 
of data on one line. This allows you to tell the value of the bus at any 
particular moment.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Run the Analyzer and View the Data
Let’s expand the data so that you can look at all eight data lines.

5 Select TCOUNT all, and choose Expand.

Now that you can see the data on all 8 bits of the training board, let’s 
change the color of data line TCOUNT 7 to red so that it stands out 
from the others.

6 Choose TCOUNT 7, and select Properties.

7 To the right of Color, select the red box, then choose OK. 
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Use Markers to Make a Timing Measurement
Use Markers to Make a Timing Measurement

You can use the global markers, G1 and G2, in the Waveform display to 
measure a time interval. The G1 and G2 global markers mark an instant 
in time that is global across all windows for all time correlated 
acquisition modules. 

1 Drag marker G2 to the falling edge of TCOUNT 0 before the 
trigger.

2 G1 should be on the rising edge on TCOUNT 0. If it is not, drag it 
there. 
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Use Markers to Make a Timing Measurement
3 Select the Markers tab.

4 To the far-right of G1, select the down arrow and choose G2.
This will give you the time between markers G1 and G2.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Save Your Work
Save Your Work

Saving your work lets you reuse measurement setups. This is helpful if 
you make the same measurement often.

1 From the Waveform File menu, select Save Configuration...

2 Go to the directory /logic/training/.

3 Select the Save tab.

4 In the Filename field, enter EDGE.

5 Select the Save button.

6 Select Close.

7 Close the Waveform window by selecting File, then Close from 
the menu bar.

8 Go back to the Setup window and select Close.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Lesson Summary
Lesson Summary

You have learned about basic timing analysis and how to make a basic 
timing measurement. 

You did the following:

✓ Set up the timing analyzer.

✓ Set up the analyzer to trigger on an edge.

✓ Ran the analyzer and viewed the waveform.

✓ Used markers to make a timing measurement.

✓ Saved your work.

What’s Next?

For more practice making basic timing measurements, go to 
chapter 4.

To learn about state analysis and how to make a basic state measurement, 
go to chapter 5.

To learn how to trigger the oscilloscope with the timing analyzer, go to 
chapter 8.

To learn how to use the pattern generator, go to chapter 9.
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Chapter 3: Introduction to Timing Analysis: Trigger on an Edge
Lesson Summary
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Verify Pulse Widths

In this chapter, you will make a timing measurement to detect pulse 
width violations. Possible uses of this measurement are to test the 
minimum and maximum pulse limits, or to verify that all pulses 
controlling a mechanical device fall within specification. 
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Chapter 4: Verify Pulse Widths
This chapter steps you through setting up the timing analyzer and bus 
labels, setting up the analyzer to trigger on a pulse width that is either 
too narrow or too wide, and using markers to measure the width of the 
pulse once it has been captured in the waveform window.

In this chapter, you will learn how to:

❏ Set up the timing analyzer.

❏ Set up the bus labels.

❏ Trigger on a pulse width violation.

❏ Run the analyzer and measure the width of the pulse.

❏ Save your work.
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Chapter 4: Verify Pulse Widths
Load the RESET Configuration File
Load the RESET Configuration File

The RESET file defaults all settings so that you can begin the 
exercises. You created the RESET file in Chapter 2.

1 Decide what to do.

• If you have just completed chapter 2, go to the next page.

• If you have reconnected the credit card board to a different 
analyzer, or if you have not created a RESET file, go to chapter 2 
“Before You Begin.”

• If you have just completed an exercise other than chapter 2, go to
step 2.

2 Select the File Manager icon from the icon bar.

3 Under Directories, go to the directory /logic/training/.

4 Under Contents of ‘training’, select the RESET file with the file 
description of the analyzer you have connected to the credit card 
board.

For example, if you are using an Agilent Technologies 16717A, you will 
select the file ‘RESET.__X’ with the file description of 
‘16717A_LA_Config’.

5 Select the Load tab.

6 Select Load.

7 Select Yes.

8 Select Close.
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Chapter 4: Verify Pulse Widths
Set Up the Timing Analyzer
Set Up the Timing Analyzer

First we will set up the timing analyzer to capture data on bit 1 of the 
credit card board.

Chapter 3 “Introduction to Timing Analysis: Trigger on an Edge”, for 
more information on timing analysis.

1 Select the analyzer you have connected to the credit card board.

2 Select Setup... from the pop-up menu to activate that 
instrument.

3 Select the Sampling tab.

4 Select Timing Mode.
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Chapter 4: Verify Pulse Widths
Set Up the Bus Labels
Set Up the Bus Labels

1 Select the Format tab.

Now you will organize the data you are capturing by creating a label 
and assigning the channels of interest to that label.

2 Select Label1, select Rename.

3 Change the label name to BIT.

BIT represents the source of the signals.

4 To the far right of BIT select the field showing the 16 channels of 
pod 1.

5 Select Individual... from the pop-up menu.
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Chapter 4: Verify Pulse Widths
Set Up the Bus Labels
6 Choose channel one to assign it to BIT, 

7 Then select OK.
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Chapter 4: Verify Pulse Widths
Define the Trigger Conditions: Trigger on a Pulse Width Violation
Define the Trigger Conditions: Trigger on a 
Pulse Width Violation

Setting up the trigger specification for verifying pulse widths would be 
a complex measurement to set up by hand. This is where trigger 
macros help out. Macros are pre-defined trigger specifications that you 
can modify for your measurement.

1 Select the Trigger tab.

2 Under the Trigger Functions tab, select ‘Find width violation on 
pattern/pulse’.
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Chapter 4: Verify Pulse Widths
Define the Trigger Conditions: Trigger on a Pulse Width Violation
3 Select Replace to replace the default trigger sequence.

Next you will define what you want to use for a trigger. Because we are 
looking for a pulse width violation, we will check the width of all high 
signals.

4 Under the Trigger Sequence 1, select Hex, then select Binary 

from the pop-up menu.

5 Select the field to the left of Binary and enter 1.

Now you will set the values for the width violation.

6 Set the min width to 42ns.

7 Set the max width to 48ns.
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Chapter 4: Verify Pulse Widths
Run the Analyzer to Verify Pulse Widths
Run the Analyzer to Verify Pulse Widths

If the analyzer triggers, it has detected a violation.

1 Select the Run icon.

2 Select the System icon.

3 Select the slot with the analyzer you are using, and select 
Waveform from the pop-up menu.

4 To the right of the Seconds/div field enter 50 ns. This will zoom 
in on the waveform.
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Chapter 4: Verify Pulse Widths
Run the Analyzer to Verify Pulse Widths
Now you’ll measure how wide the pulse width is using Markers.

5 Select the Markers tab.

6 To the far right of G1, select the down arrow after
Time from Trigger, and select G2.

7 Move G1 to the nearest rising edge before the trigger.

8 Move G2 to the nearest falling edge after the trigger.

This will give you the pulse width between markers G1 and G2.
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Chapter 4: Verify Pulse Widths
Save Your Work
Save Your Work

1 From the File menu, select Save Configuration...

2 Go to the directory /logic/training/.

3 Select the Save tab.

4 In the Filename field, enter WIDTH.

5 Select the Save button.

6 Close the Waveform window by selecting File, then Close from 
the menu bar.

7 Go back to the Setup window and select Close.
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Chapter 4: Verify Pulse Widths
Lesson Summary
Lesson Summary

You have learned how to verify pulse widths.

You did the following:

✓ Set up the timing analyzer.

✓ Triggered on a pulse width violation.

✓ Ran the analyzer and viewed the waveform.

✓ Used markers to measure the width of the pulse.

✓ Saved your work.

What’s Next?

To learn about state analysis and how to make a basic state 
measurement, go to chapter 5.

To learn how to trigger the oscilloscope with the timing analyzer, go to 
chapter 8.

To learn how to use the pattern generator, go to chapter 9.
 55



56   



5

Introduction to State Analysis: 
Trigger on an Event



Introduction to State Analysis: Trigger on an 
Event

If you’ve never used a state analyzer, you may think it’s a complex 
instrument that would take much time to master. Actually, the state 
analyzer is not any more difficult to understand than a timing analyzer. 
The major difference between a timing analyzer and a state analyzer is 
the source of the sample clock. While the timing analyzer samples at 
regular intervals using the internal clock, the state analyzer samples 
when you tell it to use an external clock. Each time the state analyzer 
receives a state clock pulse, the analyzer samples and stores the logic 
state of the system under test.

DATA

1. AA
2. 01
3. 2F
4. 3B

AA 01 2F 3BDATA

CLOCK

Sample Sample Sample Sample
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Chapter 5: Introduction to State Analysis: Trigger on an Event
In this chapter, and in chapters 6 and 7, you will make basic state 
measurements. This chapter steps you through setting up the state 
analyzer and bus labels, setting up the analyzer to trigger on an event 
and store a range of values, and viewing the listing.

In this chapter, you will learn how to:

❏ Set up the state analyzer.

❏ Set up the bus labels.

❏ Trigger on an event and store a range of values.

❏ Run the analyzer and view the listing.

❏ Search the listing.

❏ Save your work.
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Load the RESET Configuration File
Load the RESET Configuration File

The RESET file defaults all settings so that you can begin the 
exercises. You created the RESET file in Chapter 2.

1 Decide what to do.

• If you have just completed chapter 2, go to the next page.

• If you have reconnected the credit card board to a different 
analyzer, or if you have not created a RESET file, go to chapter 2 
“Before You Begin.”

• If you have just completed an exercise other than chapter 2, go to
step 2.

2 Select the File Manager icon from the icon bar.

3 Under Directories, go to the directory /logic/training/.

4 Under Contents of ‘training’, select the RESET file with the file 
description of the analyzer you have connected to the credit card 
board.

For example, if you are using an Agilent Technologies 16717A, you will 
select the file ‘RESET.__X’ with the file description of 
‘16717A_LA_Config’.

5 Select the Load tab.

6 Select Load.

7 Select Yes.

8 Select Close.
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Set Up the State Analyzer
Set Up the State Analyzer

First you must change the analyzer type from timing to state. Changing 
the analyzer type to state allows you to set up the clock as well as set 
up more complex triggers using ranges and combinations of values.

1 Select the analyzer you have connected to the credit card board.

2 Select Setup... from the pop-up menu to activate that 
instrument.

3 Select the Sampling tab.

4 Select State Mode.

Each pod has one clock channel. The clock channel on pod 1 is J. We 
will set J to sample data on the falling edge.
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Set Up the Bus Labels
5 Select the  under J, and choose Falling Edge.

Set Up the Bus Labels

1 Select the Format tab.

Now you will organize the data you are capturing by creating a label 
and assigning the channels of interest to that label.

2 Select Label1, then choose Rename.

3 Change the label name to SCOUNT.

SCOUNT is short for state count and represents the source of the 
signals.

4 To the far right of SCOUNT, select the field showing the 16 
channels of pod 1.
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Set Up the Bus Labels
5 Assign the lower 8 channels of pod 1 to SCOUNT by choosing the 
“........********” selection in the pop-up menu.

15 0

15 14 13 12 11 10 9 8 3 2 1 07 6 5 4

* * * *** * *. . . ... ..

Pod 1

78

The channels of Pod 1
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Define the Trigger Conditions: Trigger on an Event
Define the Trigger Conditions: Trigger on an 
Event

A state analyzer has “sequence levels” that let you qualify data storage. 
In this exercise, you will trigger on the pattern 3, and then only store 
the range 4-9 and pattern 10 until the analyzers memory is full.

1 Select the Trigger tab.

2 Under the Trigger Functions tab, select ‘Store nothing until 
pattern occurs’.

3 Select Replace to replace the default trigger sequence with the 
‘Store nothing until patter occurs’ trigger function.

4 In the Trigger Sequence box 1, choose Hex, then select 
Decimal from the pop-up menu.

5 Select the field to the right of SCOUNT =, and enter 003.

Trigger Store RANGE4-9 or EVENT10
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Define the Trigger Conditions: Trigger on an Event
6 Select Trigger and fill memory.

7 Select Trigger, then choose Trigger and goto.

8 Under the Trigger Functions tab, select ‘Store range until 
pattern occurs’.

9 Select Insert after to insert the ‘Store range until patter occurs’ 
trigger function after Trigger Sequence 1.

10 In the Trigger Sequence 2, choose Hex, then select Decimal 
from the pop-up menu. Do this for both instances of Hex.

11 Select the first field to the right of Store SCOUNT In range, and 
enter 004.

12 Select the field to the right of 004 and enter 009.

13 Select the field to the right of until SCOUNT =, and enter 010.
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Define the Trigger Conditions: Trigger on an Event
14 Select Next, then select 2.

You may need to enlarge the window to see the Next button.

Your trigger sequence should look like the one above.
66   



Chapter 5: Introduction to State Analysis: Trigger on an Event
Run the Analyzer and View the Listing
Run the Analyzer and View the Listing

1 Select the Run icon to capture the data.

2 Select the System icon.

3 Select the slot with the analyzer you are using, and select 
Listing....

4 Under SCOUNT select Decimal.

These line numbers show 
the locations of the data in 
the logic analyzers 
memory.

This is the state data you 
captured from the credit 
card board.
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Run the Analyzer and View the Listing
You set up the analyzer to trigger on 3 and store the range 4-9 and 10 
until the analyzer’s memory becomes full. Because the credit card 
board counts from 0 to 255 repetitively, there are many occurrences of 
“4-9, 10.” Now you will search through the listing for the beginning of 
the stored range.

5 Select the field to the right of Decimal, enter 004. 

6 Select the Next button to find the first occurrence of 
RANGE4-9.

7 Select the Next button a few more times.

Notice the line numbers are increasing and that the trigger point is no 
longer in view.

The value 004 that you are searching 
the listing for is always displayed 
inside these lines.
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Chapter 5: Introduction to State Analysis: Trigger on an Event
Save Your Work
Save Your Work

1 From the Listing File menu, select Save Configuration...

2 Go to the directory /logic/training/.

3 Select the Save tab.

4 In the Filename field, after the path /logic/training/, enter 
EVENT.

5 Select the Save button.

6 Select Close.

7 Close the Listing window by selecting File, then Close from the 
menu bar.

8 Go back to the Setup window and select Close.
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Lesson Summary
Lesson Summary

You have learned about state analysis and how to make a state 
measurement. 

You did the following:

✓ Set up the state analyzer.

✓ Triggered on an event and stored a range of values.

✓ Ran the analyzer and viewed the listing.

✓ Saved your work.

What’s Next?

For more practice making basic state measurements, go to 
chapters 6 and 7.

To learn about timing analysis and how to make a basic timing 
measurement, go to chapter 3.

To learn how to trigger the oscilloscope with the timing analyzer, go to 
chapter 8.

To learn how to use the pattern generator, go to chapter 9.
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Trigger on a Sequence of Events

With the state analyzer’s selective storage abilities, you can store only a 
portion of the data. In this exercise you will store a non-consecutive 
sequence of values before triggering the logic analyzer. This will involve 
setting up multiple levels of trigger conditions.
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Chapter 6: Trigger on a Sequence of Events
This chapter steps you through setting up the state analyzer and bus 
labels, setting up the analyzer to trigger on a sequence of events, and 
viewing the listing.

In this chapter, you will learn how to:

❏ Set up the state analyzer.

❏ Set up the bus labels.

❏ Trigger on a sequence of events.

❏ Run the analyzer and view the listing.

❏ Save your work.
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Load the RESET Configuration File
Load the RESET Configuration File

The RESET file defaults all settings so that you can begin the 
exercises. You created the RESET file in Chapter 2.

1 Decide what to do.

• If you have just completed chapter 2, go to the next page.

• If you have reconnected the credit card board to a different 
analyzer, or if you have not created a RESET file, go to chapter 2 
“Before You Begin.”

• If you have just completed an exercise other than chapter 2, go to
step 2.

2 Select the File Manager icon from the icon bar.

3 Under Directories, go to the directory /logic/training/.

4 Under Contents of ‘training’, select the RESET file with the file 
description of the analyzer you have connected to the credit card 
board.

For example, if you are using an Agilent Technologies 16717A, you will 
select the file ‘RESET.__X’ with the file description of 
‘16717A_LA_Config’.

5 Select the Load tab.

6 Select Load.

7 Select Yes.

8 Select Close.
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Set Up the State Analyzer
Set Up the State Analyzer

First you must change the analyzer type from timing to state.

Chapter 5 “Introduction to State Analysis: Trigger on an Event”, for 
more information on the state analzyer.

1 Select the analyzer you have connected to the credit card board.

2 Select Setup... from the pop-up menu to activate that 
instrument.

3 Select the Sampling tab.

4 Select State Mode.

Each pod has one clock channel. The clock channel on pod 1 is J. We 
will set J to sample data on the falling edge.
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Chapter 6: Trigger on a Sequence of Events
Set Up the Bus Labels
5 Select the  under J, and select Falling Edge.

Set Up the Bus Labels

1 Select the Format tab.

Now you will organize the data you are capturing by creating a label 
and assigning the channels of interest to that label.

2 Select Label1, choose Rename.

3 Change the label name to SCOUNT.

SCOUNT is short for state count and represents the source of the 
signals.

4 To the far right of SCOUNT, select the field showing the 16 
channels of pod 1.
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Chapter 6: Trigger on a Sequence of Events
Set Up the Bus Labels
5 Assign the lower 8 channels of pod 1 to SCOUNT by choosing the 
“........********” selection in the pop-up menu.
 77



Chapter 6: Trigger on a Sequence of Events
Trigger on a Sequence of Events
Trigger on a Sequence of Events

Now you will set up the state analzyer to find a sequence of events, 
trigger on the last event, and then store any state. This will take four 
sequence levels. The first level will find 11, the second 22, the third 33, 
and the fourth level will trigger on the occurrence of 44. The fifth level 
will be used to store all states after the trigger point until the analyzer’s 
memory is full.

1 Select the Trigger tab.

2 Under the Trigger Functions tab, select ‘Store nothing until 
pattern occurs’.

3 Select Replace to replace the default trigger sequence with the 
‘Store nothing until patter occurs’ trigger function.

4 In the Trigger Sequence 1, choose Hex, then select Decimal 
from the pop-up menu.

5 Select the field to the right of SCOUNT =, and enter 011.

1st find 2nd find 3rd find Trigger Store All
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Chapter 6: Trigger on a Sequence of Events
Trigger on a Sequence of Events
6 Select Trigger and fill memory, then choose Insert ACTION.

7 Select Store, then choose Store sample.

8 Below Store sample, select Trigger then fill memory, then 
choose Goto.

To tell the analyzer to find the rest of the sequence 022, 033, and 044 
before triggering, we will set up three more sequence levels similar to 
the one finding 011.

9 On the button bar above Trigger Sequence 1, select Insert after 
to insert a Trigger Sequence 2.

10 In the Trigger Sequence 2, choose Hex, then select Decimal 
from the pop-up menu.

11 In the Trigger Sequence 2, select the field to the right of 
SCOUNT =, and enter 022.
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Chapter 6: Trigger on a Sequence of Events
Trigger on a Sequence of Events
12 Select Goto, then choose Insert ACTION.

13 Select Store, then choose Store sample.

14 On the button bar above Trigger Sequence 1, select Insert after 
to insert a Trigger Sequence 3.

15 In the Trigger Sequence 3, choose Hex, then select Decimal 
from the pop-up menu.

16 In the Trigger Sequence 3, select the field to the right of 
SCOUNT =, and enter 033.

17 Select Goto, then choose Insert ACTION.

18 Select Store, then choose Store sample.

19 On the button bar above Trigger Sequence 1, select Insert after 
to insert a Trigger Sequence 4.

20 In the Trigger Sequence 4, choose Hex, then select Decimal 
from the pop-up menu.

21 In the Trigger Sequence 4, select the field to the right of 
SCOUNT =, and enter 044.
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Trigger on a Sequence of Events
22 Select Goto and choose Trigger, then Trigger and fill memory.
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Run the State Analyzer and View the Listing
Run the State Analyzer and View the Listing

1 Select the Run icon to capture the data.

2 Select the System icon.

3 Select the slot with the analyzer you are using, and select 
Listing... from the pop-up menu.

4 Select the Search tab.

5 Under SCOUNT, choose Hex, then select Decimal from the pop-
up menu.

Look for the sequence of events before the trigger point.

ELEVEN
TWENTY2

THIRTY3
Trigger

Store All
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Chapter 6: Trigger on a Sequence of Events
Save Your Work
Save Your Work

1 From the Listing File menu, select Save Configuration...

2 Go to the directory /logic/training/.

3 Select the Save tab.

4 In the Filename field, enter SEQUENCEVENT.

5 Select the Save button.

6 Close the Listing window by selecting File, then Close from the 
menu bar.

7 Go back to the Setup window and select Close.
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Lesson Summary
Lesson Summary

You have learned how to make a more advanced state measurement. 

You did the following:

✓ Set up the state analyzer.

✓ Triggered on a sequence of events.

✓ Ran the analyzer and viewed the listing.

✓ Saved your work.

What’s Next?

For more practice making basic state measurements, go to 
chapter 7.

To learn about timing analysis and how to make a basic timing 
measurement, go to chapter 3.

To learn how to trigger the oscilloscope with the timing analyzer, go to 
chapter 8.

To learn how to use the pattern generator, go to chapter 9.
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Trigger on a 4 Bit Serial Pattern

To trigger on a 4 bit serial pattern, the analyzer looks for a consecutive 
sequence of events. Only then will the analyzer trigger.

For this exercise, the sequence of events will be ‘0101’. The analyzer 
will not trigger if it does not find ‘0101’.
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Chapter 7: Trigger on a 4 Bit Serial Pattern
This chapter steps you through setting up the state analyzer and bus 
labels, setting up the analyzer to trigger on a 4-bit serial pattern, and 
viewing the states in the listing window.

In this chapter, you will learn how to:

❏ Set up the state analyzer.

❏ Set up the bus labels.

❏ Trigger on a 4-bit serial pattern.

❏ Run the analyzer and view the listing.

❏ Save your work.
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Load the RESET Configuration File
Load the RESET Configuration File

The RESET file defaults all settings so that you can begin the 
exercises. You created the RESET file in Chapter 2.

1 Decide what to do.

• If you have just completed chapter 2, go to the next page.

• If you have reconnected the credit card board to a different 
analyzer, or if you have not created a RESET file, go to chapter 2 
“Before You Begin.”

• If you have just completed an exercise other than chapter 2, go to
step 2.

2 Select the File Manager icon from the icon bar.

3 Under Directories, go to the directory /logic/training/.

4 Under Contents of ‘training’, select the RESET file with the file 
description of the analyzer you have connected to the credit card 
board.

For example, if you are using an Agilent Technologies 16717A, you will 
select the file ‘RESET.__X’ with the file description of 
‘16717A_LA_Config’.

5 Select the Load tab.

6 Select Load.

7 Select Yes.

8 Select Close.
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Set Up the State Analyzer
Set Up the State Analyzer

First you must change the analyzer type from timing to state.

Chapter 5 “Introduction to State Analysis: Trigger on an Event”, for 
more information on the state analyzer.

1 From the System menu, select the analyzer you have connected 
to the credit card board.

2 Select Setup... from the pop-up menu to activate that 
instrument.

3 Select the Sampling tab.

4 Select State Mode.
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Chapter 7: Trigger on a 4 Bit Serial Pattern
Set Up the State Analyzer
Each pod has one clock channel. The clock channel on pod 1 is J. We 
will set J to sample data on the falling edge.

5 Select the  under J, and select Falling Edge from the pop-
up menu.
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Chapter 7: Trigger on a 4 Bit Serial Pattern
Set Up the Bus Labels
Set Up the Bus Labels

1 Select the Format tab.

Now you will organize the data you are capturing by creating a label 
and assigning the channels of interest to that label.

2 Select Label1, then choose Rename.

3 Change the label name to BIT.

BIT represents the source of the signal.

4 To the far right of BIT, select the field showing the 16 channels of 
pod 1.

5 Select Individual... from the pop-up menu.

6 Select channel zero to assign it to BIT, then select OK to close 
the BIT window.
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Define the Trigger Conditions: Trigger on a 4-bit Serial Pattern
Define the Trigger Conditions: Trigger on a 
4-bit Serial Pattern

A serial pattern is a consecutive sequence of events. If the events do 
not occur in order, the state analyzer will never trigger.

1 Select the Trigger tab.

2 Under the Trigger Functions tab, scroll to and select 
‘Find n-bit serial pattern’.

1

2

3

4

If 0 is found, go to sequence level 2

0

1

1

0

Trigger

If 1 is found, go to sequence level 3

If 0 is found, go to sequence level 4

If 1 is found, trigger the analyzer

/0

/1

/0

/1

Else If 0 is not found, go to level 1

Else If 1 is not found, go to level 1

Else If 0 is not found, go to level 1

Else If 1 is not found, go to level 1
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Chapter 7: Trigger on a 4 Bit Serial Pattern
Define the Trigger Conditions: Trigger on a 4-bit Serial Pattern
3 Select Replace to replace the default trigger sequence with the 
‘Find n-bit serial pattern’ trigger function.

4 In the field to the left of LSB First, enter the serial pattern ‘0101’.
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Run the Analyzer and View the Listing
Run the Analyzer and View the Listing

1 Select the Run icon to capture the data.

2 Select the System icon.

3 Select the slot with the analyzer you are using, and select 
Listing...

4 Select the Search tab.

5 Under BIT, select Binary.

You may only see 0 through -3 lines of data before the trigger, which 
would show the serial pattern ‘101’. The analyzer saw the full 4-bit 
serial pattern ‘0101’ but did not display enough lines of data before the 
trigger to show you this. If you select the Run icon a couple more 
times, the -4 line of data will show up.

This is the 4-bit serial 
pattern.
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Save Your Work
Save Your Work

1 From the Listing File menu, select Save Configuration...

2 Go to the directory /logic/training/.

3 Select the Save tab.

4 In the Filename field, enter SERIAL.

5 Select the Save button.

6 Close the Listing window by selecting File, then Close from the 
menu bar.

7 Go back to the Setup window and select Close.
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Lesson Summary
Lesson Summary

You have learned how to make a more advanced state measurement. 

You did the following:

✓ Set up the state analyzer.

✓ Triggered on a 4 bit serial pattern.

✓ Ran the analyzer and viewed the listing.

✓ Saved your work.

What’s Next?

To learn about timing analysis and how to make a basic timing 
measurement, go to chapter 3.

To learn how to trigger the oscilloscope with the timing analyzer, go to 
chapter 8.

To learn how to use the pattern generator, go to chapter 9.
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Trigger the Oscilloscope with the Timing 
Analyzer

Triggering the oscilloscope with the timing analyzer is an “intermodule 
measurement,” which means it involves more than one instrument. In 
this exercise, the timing analyzer is used to trigger on the symptom, 
and the oscilloscope is used to monitor the cause. The symptom we will 
trigger on is the glitch. This capturing of data simultaneously is done by 
telling the oscilloscope to trigger after the timing analyzer triggers. In 
other words, the timing analyzer will “arm” the oscilloscope.
98   



Chapter 8: Trigger the Oscilloscope with the Timing Analyzer
In this chapter, you will capture the glitch on the credit card board by 
using the timing analyzer to trigger the oscilloscope. This chapter steps 
you through setting up the timing analyzer and bus labels, triggering on 
the glitch, making an intermodule measurement, and importing the 
analog waveform into the timing waveform window.

In this chapter, you will learn how to:

❏ Connect the oscilloscope probe and turn the glitch on.

❏ Get the analog waveform on the display.

❏ Set up the timing analyzer.

❏ Set up the timing analyzer to trigger on the glitch.

❏ Tell the oscilloscope when to trigger.

❏ Set up the analyzer to arm the oscilloscope.

❏ Run the timing analyzer and oscilloscope.

❏ Add the analog waveform to the timing waveform.

❏ Save your work.
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Chapter 8: Trigger the Oscilloscope with the Timing Analyzer
Load the RESET Configuration File
Load the RESET Configuration File

The RESET file defaults all settings so that you can begin the 
exercises. You created the RESET file in Chapter 2.

1 Decide what to do.

• If you have just completed chapter 2, go to the next page.

• If you have reconnected the credit card board to a different 
analyzer, or if you have not created a RESET file, go to chapter 2 
“Before You Begin.”

• If you have just completed an exercise other than chapter 2, go to
step 2.

2 Select the File Manager icon from the icon bar.

3 Under Directories, go to the directory /logic/training/.

4 Under Contents of ‘training’, select the RESET file with the file 
description of the analyzer you have connected to the credit card 
board.

For example, if you are using an Agilent Technologies 16717A, you will 
select the file ‘RESET.__X’ with the file description of 
‘16717A_LA_Config’.

5 Select the Load tab.

6 Select Load.

7 Select Yes.
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Chapter 8: Trigger the Oscilloscope with the Timing Analyzer
Load the RESET Configuration File
8 Under Contents of ‘training’, select the RESET file with the file 
description of 16534A_Config. This is the oscilloscope you have 
connected to the credit card board.

9 Select Load.

10 Select Yes.

11 Select Close.
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Chapter 8: Trigger the Oscilloscope with the Timing Analyzer
Connect the Oscilloscope Probe and Turn the Glitch On
Connect the Oscilloscope Probe and Turn the 
Glitch On

1 Connect the oscilloscope probe to channel 1 on the oscilloscope.

2 Connect the probe tip to the test point labeled “Glitch” on the 
credit card board.

3 Connect the probe ground lead to the test point labeled “Ground” 
on the credit card board.

4 Set the jumpers on the credit card board as shown below.

Chapter 10 “Setting the Jumpers” for more information on the jumper 
settings of J5 on the credit card board.

Pod 1 of the 
analyzer connects 
here.

The oscilloscope 
ground connects 
here.

The oscilloscope 
probe tip connects 
here.

The GLITCH is set to ON.
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Chapter 8: Trigger the Oscilloscope with the Timing Analyzer
Get the Analog Waveform on the Display
Get the Analog Waveform on the Display

Before setting up the timing analyzer and trigger, let’s get the 
waveform on the display.

1 In the Main System window, select the Oscilloscope module.

2 Select Setup/Display... from the pop-up menu.

3 In the Display window, select the Run icon to get the waveform 
on the display.

Your waveform may look different than the one in the graphic above. 
For right now, we want to see a waveform showing that the oscilloscope 
is connected to the credit card board.
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Set Up the Timing Analyzer
Set Up the Timing Analyzer

Now you will configure the timing analyzer with the label TCOUNT, the 
edge GLITCH, and the sampling speed to capture the glitch.

1 Choose the analyzer you have connected to the credit card 
board.

2 Select Setup... from the pop-up menu to activate that 
instrument.

3 Select the Sampling tab.

4 Under Timing Mode Controls, select Half Channel.

The 8 signals you will 
label TCOUNT.

The signal with the
glitch that you will 
trigger on.
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Chapter 8: Trigger the Oscilloscope with the Timing Analyzer
Set Up the Timing Analyzer
5 Select the Format tab.

6 Select Label1, then choose Rename.

7 Change the label name to TCOUNT.

8 To the far right of TCOUNT, select the field showing the 16 
channels of pod 1.

9 Assign the lower 8 channels of pod 1 to TCOUNT by choosing the 
“........********” selection in the pop-up menu.
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Chapter 8: Trigger the Oscilloscope with the Timing Analyzer
Set Up the Timing Analyzer to Trigger on the Glitch
Set Up the Timing Analyzer to Trigger on the 
Glitch

The timing analyzer is used to trigger on the glitch because it has the 
ability to capture a glitch with minimal setup.

1 Select the Trigger tab.

2 Under the Trigger Functions tab, select ‘Find glitch’.

3 Select Replace to replace the default trigger sequence with the 
‘Find glitch’ trigger function.

4 Under the Trigger Sequence 1, select the field to the far-right of 
Find TCOUNT edge.
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Set Up the Timing Analyzer to Trigger on the Glitch
5 Assign a glitch to bit 7 “*”, and assign don’t cares “.” to all other 
bits.

6 Select OK.
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Tell the Oscilloscope When to Trigger
Tell the Oscilloscope When to Trigger

The oscilloscope will capture the glitch if it is set to trigger immediately 
after the timing analyzer triggers.

1 From the Oscilloscope window menu bar, select Setup, and then 
Trigger...

2 In the Trigger Setup - Scope window, select Immediate.

This tells the oscilloscope to trigger when the timing analyzer triggers.

3 Select Close.
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Set Up the Analyzer to Arm the Oscilloscope
Set Up the Analyzer to Arm the Oscilloscope

Now that the timing analyzer is set to trigger on the glitch, and the 
oscilloscope is set to trigger after the timing analyzer, it is time to 
coordinate the run function of both instruments. This coordination is 
called “arming”, and it is set up in the Intermodule window. The 
Intermodule window shows a graphical representation of the internal 
arming sequence between instruments.

In this exercise, the oscilloscope is ‘armed by’ the timing analyzer. This 
means that for the oscilloscope to trigger, the timing analyzer must 
trigger first.

1 Go back to the Main System window.

2 Select the Inter-Module icon from the icon bar.

3 Read the pop-up descriptions.
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Set Up the Analyzer to Arm the Oscilloscope
4 Select analyzer you are using from the System window.

5 Select Group Run from the pop-up menu.

This tells the timing analyzer to begin looking for the glitch when you 
press the Group Run icon.

6 Go back to the icons under Independent and find the 
oscilloscope module you are using.

7 Select the oscilloscope icon, then choose the analyzer you are 
using.
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Set Up the Analyzer to Arm the Oscilloscope
This tells the oscilloscope to wait for the timing analyzer to trigger. We 
specified this when we told the oscilloscope to trigger immediately 
after the timing analyzer.

8 Select Close to close the Intermodule window.
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Run the Timing Analyzer and Oscilloscope
Run the Timing Analyzer and Oscilloscope

1 Go back to the oscilloscope display.

2 Select the Run Group icon to run the timing analyzer and 
oscilloscope. 

The set up you just did in the Intermodule window determines how 
Group Run performs.

3 Look at the oscilloscope display. See the glitch. Now let’s look at 
the timing waveform showing all 8 bits of the counter.

4 Go back to the Main System window.

5 Select the analyzer you are using, and choose Waveform... from 
the pop-up menu.
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Run the Timing Analyzer and Oscilloscope
6 Select TCOUNT all, then choose Expand from the pop-up 
menu.

7 Enlarge the Waveform window so that you can see all 8 data 
lines with some extra room after TCOUNT7. You will add the 
oscilloscope waveform here.
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Add the Analog Waveform to the Timing Waveform
Add the Analog Waveform to the Timing 
Waveform

Adding the oscilloscope waveform to the timing waveform display is 
useful for seeing the glitch in analog and how the glitch affects the 
other signals.

1 In the timing analyzer Waveform window, select the 
Mixed Signal tab.

2 Select the down arrow, and choose the oscilloscope.

3 Select Connect.

4 To the right of Seconds/Div enter 20ns. Now you can see the 
channels of the oscilloscope next to the timing waveform.
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Turn the Glitch Off
Turn the Glitch Off

1 Set the GLITCH jumper on the credit card board to OFF.

Save Your Work

1 From the Waveform File menu, select Save Configuration...

2 Go to the directory /logic/training/.

3 Select on the Save tab.

4 In the Filename field, enter GLITCH.

5 Select the Save button.

6 Close the Waveform window by selecting File, then Close from 
the menu bar.

7 Close the Oscilloscope window the same way you closed the 
Waveform window.

8 Go back to the Setup window and select Close.

The GLITCH is set to OFF.
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Lesson Summary
Lesson Summary

You have learned how to use the timing analyzer to trigger the 
oscilloscope, and how to view the analog and digital waveforms in the 
same window.

You did the following:

✓ Connected the oscilloscope and turned on the glitch.

✓ Got the analog waveform on the display.

✓ Set up the timing analyzer.

✓ Set up the timing analyzer to trigger on the glitch.

✓ Set up the oscilloscope to trigger immediately following the timing 
analyzer.

✓ Armed the oscilloscope by the timing analyzer.

✓ Ran the analyzer and oscilloscope.

✓ Added the analog waveform to the timing waveform.

✓ Adjusted the intermodule skew.

✓ Saved your work.

What’s Next?

To learn about state analysis and how to make a basic state 
measurements, go to chapter 5.

To learn how to use the pattern generator, go to chapter 9.
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Using the Pattern Generator

The pattern generator provides programmable digital output that can 
be used to stimulate and control a system under test. This chapter 
shows you how to program the pattern generator so that it provides a 
pattern of "walking ones." Because the pattern generator is an output 
module, the timing analyzer will be used to view the pattern generator’s 
output.

This chapter also shows you a simple process that represents basic 
stimulus/response testing. For example, if you are applying the 
"walking ones" pattern from the pattern generator to a memory, you 
can use the timing analyzer to see if the "walking ones" pattern is being 
written to and read from memory properly.
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This chapter steps you through configuring the timing analyzer, 
programming the pattern generator to output a “walking ones’ pattern, 
running the pattern repetitively, and using the timing analyzer to 
capture the pattern.

In this chapter, you will:

❏ Set up the timing analyzer and bus labels.

❏ Trigger on the pattern 1.

❏ Set up the pattern generator.

❏ Program the pattern generator.

❏ Repetitively run the walking ones program.

❏ Run the analyzer and view the walking ones pattern.

❏ Stop the pattern generator.

❏ Save your work.
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Load the RESET Configuration File
Load the RESET Configuration File

The RESET file defaults all settings so that you can begin the 
exercises. You created the RESET file in Chapter 2.

1 Decide what to do.

• If you have just completed chapter 2, go to the next page.

• If you have reconnected the credit card board to a different 
analyzer, or if you have not created a RESET file, go to chapter 2 
“Before You Begin.”

• If you have just completed an exercise other than chapter 2, go to
step 2.

2 Select the File Manager icon from the icon bar.

3 Under Directories, go to the directory /logic/training/.

4 Under Contents of ‘training’, select the RESET file with the file 
description of the analyzer you have connected to the credit card 
board.

For example, if you are using an Agilent Technologies 16717A, you will 
select the file ‘RESET.__X’ with the file description of 
‘16717A_LA_Config’.

5 Select the Load tab.

6 Select Load.

7 Select Yes.
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Connect the Pattern Generator
8 Under Contents of ‘training’, select the RESET file with the file 
description of 16720A_PG_Config. This is the pattern generator 
you have connected to the credit card board.

9 Select Load.

10 Select Yes.

11 Select Close.

Connect the Pattern Generator

Connect the pattern generator output Pod 4 to the TTL Data Pod. 
Then connect the TTL Data Pod to J4 (labeled PATTERN 
GENERATOR) on the training board.

Pod 1 of the 
analyzer connects 
here.

The TTL Data Pod 
connects here.
 121



Chapter 9: Using the Pattern Generator
Set Up the Timing Analyzer
Set Up the Timing Analyzer

First we will set up the timing analyzer to capture data on bit 1 of the 
credit card board.

Chapter 3 “Introduction to Timing Analysis: Trigger on an Edge”, for 
more information on timing analysis.

1 Select the analyzer you have connected to the credit card board.

2 Select Setup... from the pop-up menu to activate that 
instrument.

3 Select the Sampling tab.

4 Select Timing Mode.
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Set Up the Bus Labels
Set Up the Bus Labels

1 Select the Format tab.

Now you will organize the data you are capturing by creating a label 
and assigning the channels of interest to that label.

2 Select Label1, then choose Rename.

3 Change the label name to PATGEN.

PATGEN is short for pattern generator, and represents the pattern 
generator data captured by the timing analyzer.

4 To the far right of PATGEN, select the field showing the 16 
channels of pod 1.

5 Select Individual... from the pop-up menu.

6 Select channels eleven through eight.

7 Select OK.
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Define the Trigger Conditions: Trigger on a 1
Define the Trigger Conditions: Trigger on a 1

1 Select the Trigger tab.

2 The trigger function FIND PATTERN should be listed under 
Trigger Sequence 1. If it is not, select ‘Find pattern’ under the 
Trigger Functions tab, and choose Replace.

3 Select the field to the left of Hex, and enter 1.
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Set Up the Pattern Generator
Set Up the Pattern Generator

For the pattern generator to output the "walking ones" to the logic 
analyzer, the lower four bits of Pod 4, which is connected to the 
training board through the TTL Data Pod, must be assigned to 
PATGEN.

1 In the Main System window, select the Pattern Generator, and 
choose Setup... 

2 Select the Format tab.

3 Select Label1, then choose Rename.

4 Change the label name to PATGEN.

PATGEN is short for pattern generator, and represents the pattern 
generator data captured by the timing analyzer.

5 Select the field showing the 8 channels of pod 4.

6 Select Individual... from the pop-up menu.

7 Select channels three through zero, then choose OK.

8 Set all channels on all other pods, except pod 4, to “don’t cares” 
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Set Up the Pattern Generator
by selecting ‘................’ from the pop-up menus.
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Program the Pattern Generator Output
Program the Pattern Generator Output

The Sequence tab is used to program the pattern generator output. In 
this exercise, you will change the base field to binary and program the 
"walking ones" program.

1 Select the Sequence tab.

2 Under the label PATGEN, select Hex, then choose Binary from 
the pop-up menu.

3 On line 3, after MAIN START, enter ‘0001’ over ‘0000’.

4 On line 4, enter ‘0010’.
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Program the Pattern Generator Output
5 Select line 4, then choose Insert After, and then Vector.

6 On line 5, enter ‘0100’.
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Program the Pattern Generator Output
7 Select line 5, then choose Insert After, and then Vector.

8 On line 6, enter ‘1000’.

The "walking ones" program is complete. The pattern generator will 
output 0001, 0010, 0100, 1000 to the logic analyzer.
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Start the Pattern Generator and View the Walking Ones Pattern
Start the Pattern Generator and View the 
Walking Ones Pattern

When you select Run Repetitive, the Pattern Generator begins to run in 
repetitive mode. The output is the repeating "walking ones" pattern. 
You will not see this output until you switch to the timing analyzer 
waveform display.

The pattern generator will run independently until you stop it by 
selecting the Stop icon.

1 In the Pattern Generator window, select the Run Repetitive 

icon, to begin the repetitive run.

2 Select the Setup window of the analyzer you are using.

3 Select the Run icon.

The Timing analyzer runs a single trace and automatically displays the 
Waveform 1 menu in which you see the "walking ones" pattern.

4 Select the System icon.

5 Select the slot with the analyzer you are using, and choose 
Waveform.
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Start the Pattern Generator and View the Walking Ones Pattern
Let’s expand the data so that you can look at all eight data lines.

6 Select PATGEN all, and select Expand.

7 To the right of the Seconds/div field enter 20 ns. This will zoom 
in on the waveform.

This is the walking ones pattern.
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Stop the Pattern Generator
Stop the Pattern Generator

1 Select the Pattern Generator window.

2 Select the Stop icon to stop the repetitive run.

NOTE: The pattern generator requires CPU time when it is running independently in 
the repetitive mode. Stopping the pattern generator now will prevent other 
exercises that do not use it from running slower than normal.
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Save Your Work
Save Your Work

1 Close the Pattern Generator window by selecting Close.

2 From the Waveform File menu, select Save Configuration...

3 Go to the directory /logic/training/.

4 Select the Save tab.

5 In the Filename field, enter PATTERN.

6 Select the Save button.

7 Close the Waveform window by selecting File, then Close from 
the menu bar.

8 Go back to the Setup window and select Close.
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Lesson Summary
Lesson Summary

You did the following:

✓ Set up the timing analyzer.

✓ Triggered on the pattern 1.

✓ Set up the pattern generator.

✓ Programmed the pattern generator.

✓ Repetitively ran the walking ones program.

✓ Ran the analyzer and viewed the walking ones pattern.

✓ Stopped the pattern generator.

✓ Saved your work.

What’s Next?

To learn how to trigger the oscilloscope with the timing analyzer, go to 
chapter 8.
134   



Part 3

Reference





10
Setting the Jumpers



Setting the Jumpers

The jumpers on J5 of the credit card board are used to control the 
source of the state clock and to turn the glitch on or off. Before you 
start each chapter, you should check the jumpers to make sure they are 
properly set. The "To Set the Jumpers" exercise, on the next page, 
gives you the information you need to change the jumpers. Table 10-1 
shows you the jumper settings for the chapters.

Table 10-1 Jumper Settings

GLITCH CLK1

Chapter 8 ON OSC

All Other 
Chapters 
(Default)

OFF OSC
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To Set the Jumpers
To Set the Jumpers

1 Pull the appropriate jumper off of the pins of J5.

2 Push the jumper onto the correct pins of J5. You only need to 
change jumpers that differ from the settings in table 10-1.

Set the jumpers at their default settings for all chapters. Table 10-1 
shows you the default settings and the settings for each chapter. 
Chapter 8, "Trigger the Oscilloscope with the Timing Analyzer," 
requires you to change the setting of the glitch jumper.

Glitch ON

Glitch OFF

The jumpers are set here.
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About the Credit Card Board

The credit card board helps you learn the basics of Agilent 
Technologies Logic Analyzers. The following reference information is 
provided for those who want to know more about how the credit card 
board works.

Power Source

The credit card board is powered by the +5 V supplied by the logic 
analyzer pods, so a logic analyzer pod must be connected to either J1 
or J2 of the credit card board in order for the board to work. If only J2 
is connected, it must be connected to the logic analyzer through a 
termination adapter (part number 01650-63203).

CAUTION: If the termination adapter part number is Agilent 01650-63201, the CLK2 
jumper must be set to P.G. to avoid connecting the output of the oscillator to 
+5 V and eventually damaging the oscillator.

If J1 is connected, the termination adapter is not required because J1 is 
terminated on the board by Z1 and Z2.

Circuit Description

The credit card board uses an 8-bit ripple counter running at 32 MHz to 
produce transitions on the lower 8 bits of a logic analyzer pod. The 
upper eight bits can be connected to the pattern generator through 
connector J4.

For state analysis, you can clock the state analyzer using the oscillator 
on the credit card board (reference designator Y1) or using a pattern 
generator in an Agilent Technologies 16700 logic analysis system. The 
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Jumpers
sources for clocks 1 and 2 are selected by the positions of jumpers 
CLK1 and CLK2, respectively. When the CLK1 and CLK2 jumpers are 
set to OSC (oscillator), the clock source for the state analyzer is the 
oscillator on the credit card board (Y1). When the CLK1 and CLK2 
jumpers are set to P.G. (pattern generator), the clock source for the 
state analyzer is bit D7 or strobe 2 of the pattern generator, depending 
on which pattern generator pod is connected to J4.

Jumpers

The jumpers are used to turn the glitch on and off and to select the 
sources for state clocks 1 (CLK1) and 2 (CLK2).

Glitch

When the GLITCH jumper is set to OFF, the waveform on D7 of J1 and 
J2 is the most significant bit of the counter. When this jumper is set to 
ON, a glitch appears on D7 and the waveform no longer represents the 
most significant bit of the counter. The glitch always appears on the 
test point labeled GLITCH, regardless of the position of this jumper.

CLK1

The CLK1 jumper selects the source of state clock 1. If you choose OSC 
(the default), the source of the clock will be the oscillator on the 
training board. If you choose P.G., the source of the clock will be Strobe 
2 or D7 of the pattern generator, depending on which pattern 
generator pod you have connected to the credit card board.

CLK2

The CLK2 jumper selects the source of state clock 2 for the Agilent 
Technologies 16540A used in an Agilent Technologies 16700 logic 
analysis system. If you choose OSC, the source of the clock will be the 
oscillator on the credit card board. If you choose P.G. (the default), the 
source of the clock will be Strobe 2 or D7 of the pattern generator, 
depending on which pod you have connected to the credit card board.
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Credit Card Board Schematic
Credit Card Board Schematic
144   



© Copyright Agilent Technologies 
1998-2000
All Rights Reserved.

Reproduction, adaptation, or 
translation without prior written 
permission is prohibited, except 
as allowed under the copyright 
laws.

Restricted Rights Legend

Use, duplication, or disclosure by 
the U.S. Government is subject to 
restrictions set forth in 
subparagraph (C) (1) (ii) of the 
Rights in Technical Data and 
Computer Software Clause in 
DFARS 252.227-7013.  Agilent 
Technologies, 3000 Hanover 
Street, Palo Alto, CA 94304 U.S.A.  
Rights for non-DOD U.S. 
Government Departments and 
Agencies are set forth in FAR 
52.227-19 (c) (1,2).

Document Warranty

The information contained in this 
document is subject to change 
without notice.

Agilent Technologies makes 

no warranty of any kind with 

regard to this material, 

including, but not limited to, 

the implied warranties of 

merchantability or fitness for 

a particular purpose.

Agilent Technologies shall not be 
liable for errors contained herein 
or for damages in connection with 
the furnishing, performance, or 
use of this material.
Agilent Technologies
P.O. Box 2197
1900 Garden of the Gods Ro
Colorado Springs, CO 80901
Safety

This apparatus has been designed 
and tested in accordance with 
IEC Publication 1010, Safety 
Requirements for Measuring 
Apparatus, and has been supplied 
in a safe condition.  This is a 
Safety Class I instrument 
(provided with terminal for 
protective earthing).  Before 
applying power, verify that the 
correct safety precautions are 
taken (see the following 
warnings).  In addition, note the 
external markings on the 
instrument that are described 
under "Safety Symbols."

Warning

• Before turning on the 
instrument, you must connect the 
protective earth terminal of the 
instrument to the protective 
conductor of the (mains) power 
cord. The mains plug shall only be 
inserted in a socket outlet 
provided with a protective earth 
contact. You must not negate the 
protective action by using an 
extension cord (power cable) 
without a protective conductor 
(grounding).  Grounding one 
conductor of a two-conductor 
outlet is not sufficient protection.

• Only fuses with the required 
rated current, voltage, and 
specified type (normal blow, time 
delay, etc.) should be used.  Do 
not use repaired fuses or short-
circuited fuseholders.  To do so 
could cause a shock of fire hazard.
ad
-2197, U.S.A.
• Service instructions are for 
trained service personnel. To 
avoid dangerous electric shock, 
do not perform any service unless 
qualified to do so.  Do not attempt 
internal service or adjustment 
unless another person, capable of 
rendering first aid and 
resuscitation, is present.

• If you energize this instrument 
by an auto transformer (for 
voltage reduction), make sure the 
common terminal is connected to 
the earth terminal of the power 
source.

• Whenever it is likely that the 
ground protection is impaired, 
you must make the instrument 
inoperative and secure it against 
any unintended operation.

• Do not operate the instrument 
in the presence of flammable 
gasses or fumes.  Operation of any 
electrical instrument in such an 
environment constitutes a definite 
safety hazard.

• Do not install substitute parts or 
perform any unauthorized 
modification to the instrument.

• Capacitors inside the 
instrument may retain a charge 
even if the instrument is 
disconnected from its source of 
supply.
Safety Symbols

Instruction manual symbol:  the 
product is marked with this 
symbol when it is necessary for 
you to refer to the instruction 
manual in order to protect against 
damage to the product.

Hazardous voltage symbol.

Earth terminal symbol: Used to 
indicate a circuit common 
connected to grounded chassis.

WARNING

The Warning sign denotes a 
hazard.  It calls attention to a 
procedure, practice, or the like, 
which, if not correctly performed 
or adhered to, could result in 
personal injury.  Do not proceed 
beyond a Warning sign until the 
indicated conditions are fully 
understood and met.

CAUTION

The Caution sign denotes a 
hazard.  It calls attention to an 
operating procedure, practice, or 
the like, which, if not correctly 
performed or adhered to, could 
result in damage to or destruction 
of part or all of the product.  Do 
not proceed beyond a Caution 
symbol until the indicated 
conditions are fully understood or 
met.

!



Product Warranty

This Agilent Technologies 
product has a warranty against 
defects in material and 
workmanship for a period of one 
year from date of shipment.  
During the warranty period, 
Agilent Technologies will, at its 
option, either repair or replace 
products that prove to be 
defective.

For warranty service or repair, 
this product must be returned to 
a service facility designated by 
Agilent Technologies.

For products returned to Agilent 
Technologies for warranty 
service, the Buyer shall prepay 
shipping charges to Agilent 
Technologies and Agilent 
Technologies shall pay shipping 
charges to return the product to 
the Buyer.  However, the Buyer 
shall pay all shipping charges, 
duties, and taxes for products 
returned to Agilent Technologies 
from another country.

Agilent Technologies warrants 
that its software and firmware 
designated by Agilent 
Technologies for use with an 
instrument will execute its 
programming instructions when 
properly installed on that 
instrument.  Agilent Technologies 
does not warrant that the 
operation of the instrument 
software, or firmware will be 
uninterrupted or error free.

Limitation of Warranty

The foregoing warranty shall not 
apply to defects resulting from 
improper or inadequate 
maintenance by the Buyer, 
Buyer- supplied software or 
interfacing, unauthorized 
modification or misuse, operation 
outside of the environmental 
specifications for the product, or 
improper site preparation or 
maintenance.
No other warranty is 

expressed or implied.  Agilent 

Technologies specifically 

disclaims the implied 

warranties of merchantability 

or fitness for a particular 

purpose.

Exclusive Remedies

The remedies provided herein are 
the buyer’s sole and exclusive 
remedies.  Agilent Technologies 
shall not be liable for any direct, 
indirect, special, incidental, or 
consequential damages, whether 
based on contract, tort, or any 
other legal theory.

Assistance

Product maintenance agreements 
and other customer assistance 
agreements are available for 
Agilent Technologies products. 
For any assistance, contact your 
nearest Agilent Technologies 
Sales Office.

Certification

Agilent Technologies certifies that 
this product met its published 
specifications at the time of 
shipment from the factory.  
Agilent Technologies further 
certifies that its calibration 
measurements are traceable to 
the United States National 
Institute of Standards and 
Technology, to the extent allowed 
by the Institute’s calibration 
facility, and to the calibration 
facilities of other International 
Standards Organization members.
About this edition

This is the Making Basic 

Measurements Training Kit for 

the Agilent Technologies 16700 

Series Logic Analysis System.

Publication number
16700-97013, May 2000
Printed in USA.

New editions are complete 
revisions of the manual.  Many 
product updates do not require 
manual changes, and manual 
corrections may be done without 
accompanying product changes. 
Therefore, do not expect a one-
to-one correspondence between 
product updates and manual 
updates.
UNIX is a registered trademark in 
the United States and other 
countries, licensed exclusively 
through X/Open Company 
Limited.


	Making Basic Measurements: a self-paced training guide
	What materials do I need?
	If you are using an older analyzer

	In This Book
	Part 1: A Quick Tour
	Part 2: Making Basic Measurements
	Part 3: Reference

	What Other Sources of Information Are There?
	Installation Guide
	Online Help System
	Measurement Examples

	A Quick Tour
	A Quick Tour
	Your Agilent Technologies 16700-Series Logic Analysis System
	When Should I Use a Logic Analyzer?
	What is a Logic Analyzer?
	What is a Timing Analyzer?
	What is a State Analyzer?

	The Main System Window
	The Measurement Process
	Define the type of measurement
	Set up the bus labels
	Define trigger conditions
	Run the measurement
	Examine the data



	Before You Begin
	Before You Begin

	Introduction to Timing Analysis: Trigger on an Edge
	Introduction to Timing Analysis: Trigger on an Edge
	In this chapter, you will learn how to:
	Load the RESET Configuration File
	Set Up the Timing Analyzer
	Set Up the Bus Labels
	Define Trigger Conditions: Trigger on an Edge
	Run the Analyzer and View the Data
	Now that you can see the data on all 8 bits of the training board, let’s change the color of data...

	Use Markers to Make a Timing Measurement
	Save Your Work
	Lesson Summary
	What’s Next?



	Verify Pulse Widths
	Verify Pulse Widths
	In this chapter, you will learn how to:
	Load the RESET Configuration File
	Set Up the Timing Analyzer
	Set Up the Bus Labels
	Define the Trigger Conditions: Trigger on a Pulse Width Violation
	Run the Analyzer to Verify Pulse Widths
	Save Your Work
	Lesson Summary
	What’s Next?



	Introduction to State Analysis: Trigger on an Event
	Introduction to State Analysis: Trigger on an Event
	In this chapter, you will learn how to:
	Load the RESET Configuration File
	Set Up the State Analyzer
	Set Up the Bus Labels
	Define the Trigger Conditions: Trigger on an Event
	Run the Analyzer and View the Listing
	Save Your Work
	Lesson Summary
	What’s Next?



	Trigger on a Sequence of Events
	Trigger on a Sequence of Events
	In this chapter, you will learn how to:
	Load the RESET Configuration File
	Set Up the State Analyzer
	Set Up the Bus Labels
	Trigger on a Sequence of Events
	Run the State Analyzer and View the Listing
	Save Your Work
	Lesson Summary
	What’s Next?



	Trigger on a 4 Bit Serial Pattern
	Trigger on a 4 Bit Serial Pattern
	In this chapter, you will learn how to:
	Load the RESET Configuration File
	Set Up the State Analyzer
	Set Up the Bus Labels
	Define the Trigger Conditions: Trigger on a 4-bit Serial Pattern
	Run the Analyzer and View the Listing
	Save Your Work
	Lesson Summary
	What’s Next?



	Trigger the Oscilloscope with the Timing Analyzer
	Trigger the Oscilloscope with the Timing Analyzer
	In this chapter, you will learn how to:
	Load the RESET Configuration File
	Connect the Oscilloscope Probe and Turn the Glitch On
	Get the Analog Waveform on the Display
	Set Up the Timing Analyzer
	Set Up the Timing Analyzer to Trigger on the Glitch
	Tell the Oscilloscope When to Trigger
	Set Up the Analyzer to Arm the Oscilloscope
	Run the Timing Analyzer and Oscilloscope
	Add the Analog Waveform to the Timing Waveform
	Turn the Glitch Off
	Save Your Work
	Lesson Summary
	What’s Next?



	Using the Pattern Generator
	Using the Pattern Generator
	Load the RESET Configuration File
	Connect the Pattern Generator
	Set Up the Timing Analyzer
	Set Up the Bus Labels
	Define the Trigger Conditions: Trigger on a 1
	Set Up the Pattern Generator
	Program the Pattern Generator Output
	Start the Pattern Generator and View the Walking Ones Pattern
	Stop the Pattern Generator
	Save Your Work
	Lesson Summary
	What’s Next?



	Setting the Jumpers
	Setting the Jumpers
	To Set the Jumpers


	About the Credit Card Board
	About the Credit Card Board
	Power Source
	Circuit Description
	Jumpers
	Glitch
	CLK1
	CLK2

	Credit Card Board Schematic



